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Overview 
Specification of CNCnet DNC 
CNCnet DNC can perform bi-directional communications with an unlimited number of serial devices 
simultaneously (up to 16 serial devices per instance, you can install multiple instances of the program). 
The possible speed of NC file transmission depends a great deal on the type of serial ports you are using 
and the length of the cable between the CNC's serial interface and the serial port of the computer / CNC 
network adapter. While CNCnet-DNC will run on slower computers, we recommend that you use at least 
a Pentium 4 computer with Operating System Microsoft Windows 2000 SP5 for typical applications. 
Your serial ports must be of the ”buffered” type, using a 16550 UART chip (or equivalent). Non-buffered 
serial ports will seriously affect performance, limiting the baud rate at which communications will be 
reliable. With Inventcom CNCnet DNC you can 

 

• Transmit NC-Files, machine parameters and tool setting information’s from and to your CNC 
machines 

• Manage your NC-Files 
• Edit your NC-Files with various Editors or manipulate / translate the content of the file automatically 

by using Pre- or Postprocessors. 
 
Beside of its transmission capabilities Inventcom CNCnet DNC also allows you 

 

• to communicate with your controls via manufacturer specific protocols (like Heidenhain or Mazatrol 
CMT) 

• to connect machines that do not have a serial interface by using the tape reader simulator 
functionality 

• the control of all functions (transmission / reception) from the operator panel of the machine 
• highest transmission rates on all channels 
 

All DNC functions and settings can be set, modified and saved (machine specific) within CNCnet DNC. 
For security purposes the integrated password protection functions can be activated. 

 

See also: 

Structure of system »Page 8 

Operating CNCnet DNC »Page 7 



 

 
inventcom 

 

 

Inventcom CNCnet DNC Ver. 8.4.1.3 
http://www.inventcom.us · info@inventcom.net  
Version : Jul. 2010 V1.2 
Page 5 of 65 

*00004062* 

 

 

 

 

 

 

 

Installation 
Here’s a short description of the installation procedure of CNCnet DNC. First you should check that all 
parts for successfully building a machine network are available. This includes: 

 

1. The CNCnet DNC Software installer file (.MSI Microsoft Windows Installer) 

2. A computer that is connected to your network and runs an Operating System from Microsoft 
Windows 2000 SP 5 up to Microsoft Windows Server 2008. 

3. One or more serial ports that are installed directly on the main board of your computer or a 
multiport serial interface card or CNC network adapters. If you use CNC network adapters make 
sure that they are installed and visible on your computer before you set up CNCnet DNC. 

4. Appropriate serial cable connections to your machines serial interface. 

 

Minimum requirements on computer: 

While CNCnet-DNC will run on slower computers, we recommend that you use at least a Pentium 4 
computer for typical applications. The computer hardware required mainly depends on the operating 
system you’re using. 

E.g. for Microsoft Windows 2000 this would be: 

• PC AT >= 486 compatible 
• 64 MB RAM (minimum) 
• 5 MB of free hard disk space for the application (without regard to your NC files 
• VGA compatible graphics adapter with a minimum resolution of 800x600 pixels 
Operating Systems supported by CNCnet DNC: 

• Microsoft Windows 2000 (SP4) 
• Microsoft Windows XP (x32-x64*) 
• Microsoft Windows Vista (x32-x64*) 
• Microsoft Windows Server 2003 (x32-x64*) 
• Microsoft Windows Server 2008 (x32-x64*) 
* For operation of CNCnet DNC on computers running a 64-bit OS a 32-bit Guest OS has to be installed. 
By default one of the following virtualization technologies may be used: 

• Microsoft Virtual PC 2004  2007 
• Microsoft Virtual Server 2005 
• Microsoft Hyper V Server 2008 
Hardware for serial connections to CNC machines: 

• A sufficient number of serial ports for connecting the controls. The serial ports must be of the 
”buffered” type, using a 16550 UART chip (or equivalent). Non-buffered serial ports will seriously 
affect performance, limiting the baud rate at which communications will be reliable. 

• If you plan to run your network with CNC network adapters the TCP/IP network protocol has to be 
installed on the computer. Network cabling to the machines is required. 

 

See also: 

Installation on Windows 2000 »Page 6 

Configure Serial Port Hardware »Page 20

Configure Port  »Page 23

Configure System »Page 36

Configure Aliases »Page 39

Configure Processors »Page 42

Example: Putting CNCnet DNC into operation  »Page 53
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Installation on Windows 2000 
For an optimal performance of the DNC System on Microsoft Windows 2000 Operating System Service 
Pack 5 should be applied. Please follow the instructions below to install the software: 

Setup the serial ports on your computer and verify their existence by using Computer Management -> 
Device Manager -> Ports (COM and LPT) before you install CNCnet DNC software. Make a note of the 
COM port numbers as shown in Device Manager. 

 

• Navigate to the place where you have stored the Windows Installer package CNCnet_DNC.msi 
• Double-click CNCnet_DNC.msi 
• The installers welcome dialog window for CNCnet DNC appears 
• Confirm the install directory suggested by the installer or choose your desired install directory. 
• The installer copies and registers all files required for running CNCnet DNC. Shortcuts to launch 

CNCnet DNC are created within your programs menu folder and on your desktop. 
• After you confirm the installers information dialog window installation of CNCnet DNC is complete. 
• If you already have a DEMO Version of CNCnet DNC installed on your computer you can simply 

install the licensed version over the existing one. 
 

See also: 

Configure Serial Port Hardware »Page 20

Configure Port  »Page 23

Configure System »Page 36

Configure Aliases »Page 39

Configure Processors »Page 42

Example: Putting CNCnet DNC into operation  »Page 53
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Operating CNCnet DNC 
As with many WINDOWS applications CNCnet DNC can alternatively be controlled by either mouse or 
keyboard (SAA compatible = ALT key + character underlined) 

To launch the programs functions you can use CNCnet DNC’s command windows menu (at the very top) 
and a symbol menu (below) 

 

 
 

The symbol menu contains common functions out of the command windows contents. 

If you select a menu item from the command windows contents a list of all possible functions appears 
below the item. 

Functions and settings that refer to a single machine can be accessed quickly by clicking the machine 
with the left mouse button followed by the right mouse button. A menu appears were you quickly can 
select functions for the selected machine. 

Most of the programs functions offer context specific help. Context specific help can be accessed either 
by clicking the Help” button within the functions menu or by choosing the menu item Help from the 
main window. 

To end CNCnet DNC you can use different, well known WINDOWS functions. You can either choose File  
End from CNCnet DNC’s command windows menu, press ALT F + N or ALT + F4 on your keyboard or 
double-click the left edge on the top of the CNCnet DNC application. To end the program you may have 
to change the permissions level according to your security policy. 

 

See also: 

Functions »Page 9 
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Functions of CNCnet DNC 
Structure of system 
CNCnet DNC consists of the following components: 

 

 
 

CNCNET DNC is responsible for... 

• the setting of the systems parameters 
• the control of all transmission processes 
• the status indication concerning protocols and transmission processes 
• the file access from the machine control to local or network folders and drives 
• the integration of various NC File editors 
• the storage of all events concerning NC File transmissions 
• the security configuration of the DNC machine network 
 

Multiport serial interface cards and CNC network adapters are responsible for... 

• the handling of the transmission process in concern of timing, speed and latency (the 
implementation of virtual serial devices can also be made by manufacturer specific products that 
work compliant with Inventcom’s transmission standards) 
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Functions of CNCnet DNC 
Here you can find a description of all possible functions of the program. For making yourself comfortable 
with all functions you should first work through an example.  

It is important for all functions that you select the desired machine/control prior to performing a specific 
function. For example if you launch File  Edit NC-File CNCnet only shows the files that belong to the 
selected machine. The actually selected machine / control is shown by a red icon in front of the 
machines name. To avoid confusion: The machines / controls listed in the main window are called Ports” 
in CNCnet DNC. 

 

 
 

In this particular example the machines Alzmetall (sends) and GLD20 (receives) are active. Just click on 
the machines / controls name to select it for further actions. The red icon changes its position 
accordingly. 

 

Additional functions: 

Edit NC File »Page 10 

 

 

 

 

 

 

 

 

 

Delete NC File »Page 11

NC File manager »Page 12

Send NC File »Page 13

Receive NC File »Page 14

Turn off / Turn on port »Page 16

Command queue »Page 17

Processor »Page 18

Reset »Page 15

Reset all »Page 19
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Edit NC File 
You can launch the CNCnet DNC NC File Editor from the command windows File menu (Alt-F + E), by 
clicking the symbol , by pressing F4 on your keyboard or by using the NC File Manager (Key F10). In 
CNCnet DNC’s file list box you can select a NC file for editing. 

 

 
 

What’s an Alias? 

An alias is just a translation of a long, maybe difficult to enter expression into a short name, for example 
N:\\HWK003\99\NCPROG\AXA01\ is translated into AXA1. For editing you can select NC-files out of the 
aliases that are configured for the machine that is actually selected in the main window:  Configure 
Aliases »Page 39 

 

 

 

 

Comfortable editing of NC Files you can also be done by using the NC File manager »Page 12

 

See also: 

Send NC File »Page 13

Receive NC File »Page 14

Delete NC File »Page 11
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Delete NC File 
After selecting this function from the command windows File menu (Alt-F + D), by clicking the symbol  
or by pressing F8 on your keyboard you can choose the NC-file you’d like to delete: 

 

 
 

 You can also delete NC-Files by using the NC File manager »Page 12
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NC File manager 
You can launch CNCnet’s NC File manager from the command windows File menu (Alt-F + M) or by 
pressing F10 on your keyboard. 

 

 
 

The NC File manager allows you to 

select one or more NC Files (By using CTRL + mouse click left you can select multiple NC Files) 

copy, rename or delete multiple NC files 

To process multiple NC Files in a single operation: 

1. Select the desired Aliases for source and target. 

2. Select the NC File or Files you’d like to work with. You can use the switch Filter” to select files by 
wildcard characters. Usage of wildcard characters: 

 

* The star wildcard has the broadest meaning of any of the wildcards, as it can represent zero 
characters, all single characters or any string. 

(e.g. F*.* = all NC Files that begin with F like F1234567.NC or FABCDEFG.DAT) 

? The question mark (?) is used as a wildcard character to represent exactly one character, which can be 
any single character. Thus, two question marks in succession would represent any two characters in 
succession, and three question marks in succession would represent any string consisting of three 
characters. 

(e.g. F123456?.NC can be F1234567.NC or F123456A.NC) 

3. Select the desired function (copy...) 

 

See also: 

Edit NC File »Page 10 

 Delete NC File »Page 11
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Send NC File 
If you want to ”force” CNCnet DNC to output a NC-File, such as when sending to tape punch/readers 
etc., click the ”Send NC-File” panel. Normally, a CNC control will request the output of data using a Xon 
control code, or the serial ports CTS signal. If the external device cannot handshake using Xon/Xoff or 
RTS/CTS, you must use the Send NC File panel to send a file. You can also launch this function from the 
command windows File menu (Alt-C + S), by pressing CTRL+S on your keyboard or by clicking the 
symbol 

 
CNCnet DNC’s list box for NC File selection appears: 

 

 
After selection of the NC File and confirmation (Button OK or Keyboard: Enter) the selected machine 
changes its color and is now ready to send: 

 

 
 

While the function Send NC File is active the symbol to interrupt the current transmission 

 
also gets active and may be used to terminate the current process. 

 

Send automatically via Remote Commands): 

Configure Terminal Mode »Page 32 
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Receive NC File 
If you want to ”force” CNCnet DNC to receive and store the contents of whatever is sent by the 
machine click the ”Receive NC-File” panel. If you currently do not have the Auto Code Recognition” 
function turned on or if the external device does not send recognizable characters (e.g. binary code) you 
must use the Receive NC File panel to name and receive. You can also launch this function from the 
command windows File menu (Alt-C + R), by pressing CTRL+R on your keyboard or by clicking the 
symbol 

 
CNCnet DNC’s list box for naming the NC File appears: 

 

 
 

After you’ve entered a name for the NC file and confirmed your input (Button OK or Keyboard: Enter) the 
selected machine changes its color and is now ready to receive (GLD 20). You can now send the NC File 
from the control. 

 

 
 

Receive and name NC Files automatically by the use of Auto Code Recognition: 

Auto Code Recognition »Page 24 
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Reset 
As long as a transmission or reception process is active the Reset symbol 

 
may be used to terminate the current operation. Alternatively this function can be launched from the 
command windows File menu (Alt-C + T) or by pressing CTRL+B on your keyboard. After selection of 
this function a confirmation window 

 

 
 

appears. Tip: selecting Delete Queue” is only relevant if, after the current file more NC-Files are still 
waiting for transmission to the control. 

 

See also: 

Reset all »Page 19 
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Turn off / Turn on port 
This function can be either launched by pressing (ALT-C + D) / (ALT-C + E) or by clicking the symbols  
(switch on port) and  (switch off port). By using this function you can enable or disable all DNC 
functionality for the selected machine. A port that is turned off is shown by 

 

 
 

a port that is turned on is shown by 

 

 
 

DNC  Functions are only available if a port is turned on 
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Command queue 
A ”queue” is simply a list of files that are sent to the CNC in sequence. Each machine has its own queue 
list. Each file in the queue list is queued up and waits to be sent to the CNC. There are easy ways to 
queue up files: You can use the command windows ”Command” menu and Command Queue” to add 
delete or remove files from a CNC’s queue list. To use the queue functionality this feature has to be 
turned on in the Configure Port” dialog window.  

You can either switch on Queue by pressing (ALT-C + C) on your keyboard or by clicking on the symbol 
. After entering of 3 commands, the queue looks like: 

 

 
 

You can use and view the queuing list independently for every machine. By using the command Delete” 
you can clean up the whole queue. A single entry can be removed by pressing the Remove” button after 
selection of the entry. The entry then disappears from the queue. 
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Processor 
Processors are programs that process input data to produce output that is used as input to another 
program. The output is said to be a processed form of the input data, which is often used by some 
subsequent programs like CAM applications. The amount and kind of processing done depends on the 
nature of the processor, most processors are performing relatively simple textual substitutions and 
macro expansions. 

A Preprocessor runs before the NC File is sent to the machine whereas a Postprocessor runs after 
reception of an NC File from the machine. Typical cases of applications are: 

 

• Separation a NC File into pieces (main program  sub program) 
• Translation of the NC File format from one machine type to another (e.g. from Fanuc 4-axis wire 

EDM to AGIE 4-axis) 
 
You can launch and start CNCnet’s processors independently from active DNC transmission processes 
from the command windows Command menu (Alt-C + P) or by clicking the symbol . 

 

 
 

Select the processor, enter the name of the file that should be affected and, if needed, enter command 
line parameters to control the execution. 

 

Tip: Processors compiled with a 32-bit compiler can be simply started by the auxiliary program 
START32.EXE. As processor select START32.EXE and fill in a /P in the Command Line Parameters field 
followed by the name of your processor without any white space characters between /P and your 
processor. Is your processors name CAMNEW.EXE you just have to enter /PCAMNEW eventually 
followed by your specific switches for execution. 

 

See also: 

Configure Processors »Page 42 
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Reset all 
This command resets all active transmission processes at once. This function is not supported when 
using the Windows API interface driver APICOMM. 

 

See also: 

Reset »Page 15
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Configuration of CNCnet DNC 
Configure Serial Port Hardware 
Hardware in CNCnet DNC refers to your physical or virtual COM Ports on your computer. As you need 
the COM port numbers as assigned by the operating system for setup of CNCnet DNC you have to look 
for them by using Computer Management -> Device Manager -> Ports (COM and LPT). Make a note of 
the COM port numbers as shown in Device Manager. 

For selection of the device driver model you’d like to use for the assignment of the computers COM 
Ports to Ports in CNCnet DNC you get this configuration window: 

 

 
 

All parameters refer to the hardware settings of the COM ports. If you do not work with special interface 
boards or a very old OS select APICOMM.DLL as your device driver. Use the dropdown field Number 
Ports” to tell CNCnet DNC how many ports you’d like to be used by this instance of CNCnet DNC. After 
a restart of the program you can assign the computers COM ports to ports in CNCnet DNC: 

 

Configure serial interface cards »Page 21 

 

 

 

 

 

Manufacturer specific COM server products from W&T can be integrated by the use of a specific device 
driver available from Inventcom. If you are using such devices here’s a tutorial for the setup of the device 
driver: 

 

Configure W&T COM servers »Page 22

 

Please note that within a program instance that is working with this special device driver standard COM 
ports cannot be used. In such case, you have to create on program instance for W&T devices and one for 
standard COM ports. 

 

After installation of the Serial Port Hardware you can continue with the configuration of the 
ports, the aliases and the system settings: 

Configure Port  »Page 23

System Settings »Page 36

Configure Aliases »Page 39
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Configure serial interface cards 
For setting up the parameters for serial interface cards the hardware configuration (command windows 
Configuration menu  hardware) has to be set to driver APICOMM.DLL and the Number of Ports has to be 
defined. After restarting the program you can access the configuration dialog by pressing the 
Configuration button: 

 

 
 

COM Port: Shows the currently selected port and its settings. 

FIFO* Receive buffer: Size of the serial buffer for data reception (should usually be set to 4000) 

FIFO* Transmit buffer: Size of the serial buffer for data transmission (should usually be set to 4000) 

By clicking the button Modify you can store your settings for the currently selected port. 

 

* If your PCs serial port has a 16550 UART chip (CNC network adapters are compatible to this chip), you 
can use its FIFO” (First In, First Out) buffer to greatly improve the performance of the serial port - 
especially when the computer is receiving data. Without this buffer, the computers OS receives an 
interrupt every time a single character comes in to the port. At higher baud rates, Windows may not be 
fast enough to service these interrupts, and may loose characters. With the FIFO buffer, Windows is 
only interrupted when the UART chips FIFO buffer is full, which means that it can handle several 
characters at a time, resulting in a much higher speed. 

 

Tip: Using FIFO buffering will give better performance, but may cause a Buffer overflow” alarm on some 
CNC’s. If you get this alarm, set the FIFO Transmit” buffer to a lower setting. 

 

Tip: Please note that due to the device naming convention of Windows COM Port Numbers higher than 
9 have to be entered as //./COMnn where nn is the COM Port number (e.g. //./COM10 for COM10) 

 

Tip: The order of COM Ports in the left pane is equal to the order of the machines in CNCnet DNC’s 
main window. 

 

After installing the COM Port hardware you can continue with setting port I/Os and testing your 
COM ports: 

Configure Port I/O »Page 25 

 

 

 

Test COM Port »Page 48

Analysis Monitor »Page 49

Analyzer »Page 50
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Configure W&T COM servers 
For setting up the parameters for W&T COM servers the hardware configuration (command windows 
Configuration menu  hardware) has to be set to driver DNCTCPIP.DLL and the Number of Ports has to be 
defined. After restarting the program you can access the configuration dialog by pressing the 
Configuration button: 

 

 
 

Address: Shows the TCP/IP addresses of all currently installed devices together with the port that the 
machine uses (Port A, Port B). If no device is already installed default values from 1.1.1.0 to 1.1.1.n are 
set. 

Port A / B: COM Port of the COM server Device that is used by the machine 

New: For debug purposes only, can safely left OFF. 

Debug wind.: Shows details about the communication activities between device driver and device on 
startup of CNCnet DNC. For debug purposes only. Can and should normally be left OFF. 

Refresh: Refresh interval (milliseconds) between device driver and device. Used to refresh/rebuild socket 
communication between driver and device (Should be set to => 50000) 

Clear errors: Clears display for error messages at the devices LCD automatically. (Should be turned ON 
by default) 

By clicking the button Modify you can store your settings for the currently selected port. 

 

After installing the COMSERVER hardware you can continue with setting port I/Os and testing 
your COM ports: 

 

Configure Port I/O »Page 25 

 

 

Analysis Monitor »Page 49

Analyzer »Page 50
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Configure Port  
You can launch CNCnet’s Port configuration settings by either clicking with the right mouse key on the 
selected port or from the command windows Configuration menu (Configuration - Port - Parameters). 
The currently selected machine is shown by the red icon left to the machines / controls name 

Port/Parameters 

Here, some general settings for the machine can be set: 

 

 
 

Parameters: 

• Machine: The name of the machine / control that is shown in the main menu 
• Mode: DNC  Currently selected transmission method. If you are working with a manufacturer 

specific transmission protocol like Mazatrol or Heidenhain you should switch to Protocol and select 
the desired protocol type: 
Configure Port Protocol »Page 27 

 

 

 

 

 

 

• Queue Delay (Sec.): Delay between NC commands that are executed in a queue. This applies only 
when Queue active is switched on. 

• Distance: Time delay between NC Files that are sent in a queue. This applies only when Queue 
active is switched on. This helps that multiple NC files do not get mixed up in the CNC (e.g. all stored 
in the same NC File). 

 

Tip: If you are working with a machine specific protocol you can adjust the detail settings of the selected 
protocol by clicking with the right mouse key on the machine, select protocol and click on the protocol 
type. An additional window opens. 

 

Automatically receive and name NC Files: Auto Code Recognition »Page 24

Configure serial I/O parameters: Configure Port I/O »Page 25

Filter, delete, replace and modify characters: Configure Character Handling »Page 30

Send and receive files using remote commands from the CNC: Configure Terminal Mode »Page 32

Setup of alias names for directories and extensions: Configure Port Aliases »Page 34

Load, save and lend port settings: Configure Port Options »Page 35
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Configure Auto Code Recognition 
This option determines whether or not CNCnet DNC will use automatic code recognition when receiving 
data. This feature sets the name of the NC File received according to characters that follow a 
synchronization character and stores it on your hard disk. The settings here are also essential for working 
with remote commands (Terminal Mode) cause CNCnet DNC only reacts to specific names, which are 
built by the Auto Code Recognition function. The parameters for building these names out of the 
characters arriving are set here: 

 

 
 

Parameters: 

• Settings - Active. If this option is set ON the port is waiting for commands from the CNC and the 
status display in the main window changes to waiting”. 

• Reception discontinues active sending. If data from the CNC is received a current active sending 
process is terminated. (Applies also if you have set long timeout values for sending) 

• Min. Chars. / Timeout. If the number of characters (Min. Chars.) was received or the time (Timeout) 
expired and no synchronization character was found CNCnet DNC discontinues with auto code 
recognition. 

• Parameter Set: 5 different sets for synchronization and building names from incoming data. 
• Valid Characters: Numeric / Alphanumeric  allows / disallows numbers or characters when building 

names. Max defines the maximum length of the filename built by auto code recognition. 
• Filter: Filters out unwanted characters (e.g. If you filter the expression _ from the incoming data 

%1233_44 you get a 123344.nc if your synchronization expression is % and your extension is .nc) 
• Generate NC-Filename from: Here you set the synchronization character (like %) or expression (like 

PGM) that should be used to find the characters for building the NC Files name. Any white space 
characters in incoming data are ignored (e.g. P G M = PGM) 

• Add before Name / Add after Name: Fixed expression that is added to the NC Files name beginning / 
end. Add ARB before name creates ARB1233.NC out of 1233. 

• Fill to Length: Length of NC Filename and character to use when filling. Setting of 10 with 0 creates 
0000003443 out of 3443. 

• Extension: Extension to use for saving the NC File to disk. The extension to use has to be already 
defined for the specific machine as an extension alias. 

 

Manually receive an NC File: 

Receive NC File »Page 14 
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Configure Port I/O 
Serial port settings for the selected port: 

 

 
 

Parameters: 

• Baud rate: Standard baud rates are available from 110 to 115,200 baud. The baud rate setting for the 
port MUST MATCH the baud rate used by your CNC control. Please note that the x16 switch can 
only be used for controls that are able to deal with high speed transmission! 

• Stop” bits: Can be set to send/receive data with a stop-bits setting of 1”, or 2”. The stop-bits 
settings MUST MATCH the settings of your CNC control, otherwise unreliable communications may 
occur. 

• Data” bits: The Data Bits setting should normally be set to 7” for ASCII Even Parity and ASCII Odd 
parity tape codes. A setting of 8” is typical for all other tape codes. 

• Handshaking: When CNCnet DNC sends or receives a file to or from the CNC, it can be set to 
handshake” with the CNC in 4 different ways. Xon/Xoff is the most common form of handshaking, 
and is used with most popular CNC controls. Xon/Xoff is also referred to as DC codes” or Device 
Control” codes by some CNC manufacturers. 

• Xon/Xoff Handshaking 
When Xon/Xoff protocol is selected, CNCnet-DNC will halt transmission temporarily if a Xoff (also 
known as DC3”) character is received. When a Xon character (DC1) is received, DNC will resume 
transmission. In any handshake mode, CNCnet DNC will time-out” if an Xoff control code halts 
transmission for more than the time values you set in Receive Timeout / Send timeout. 

• RTS/CTS Handshaking 
When RTS/CTS handshaking is selected, CNCnet DNC will halt transmission if the CTS signal (pin #5 
on a 25 pin plug or pin #8 on a 9-pin plug) goes low. When a file is requested remotely, CNCnet DNC 
will wait for the CTS signal to go high before transmitting. Once transmission begins, the CNC can 
momentarily halted by turning off CTS. By setting a higher value for Receive Timeout you can extend 
the time for the operator at the machine to switch from send NC-File to receive NC-File when 
working with remote commands. 

• 7 Bit Mask: Deletes the 8th Bit when receiving data 
• Send Timeout (TXD) Before Start: CNCnet stops with transmission after this amount of seconds 

before sending has begun (no characters transmitted) 
• Send Timeout (TXD) After Start: CNCnet stops with transmission after this amount of seconds after 

sending already has begun. 
• Terminate on: Sets specific error conditions where CNCnet should terminate the transmission. If 

these switches are turned off CNCnet DNC shows errors but still continues with transmission. 
• Character delay: Time delay between characters (ms). In special situations, it may be necessary to 

have a slight time delay in between every character transmitted to the CNC. Normally, this feature IS 
NOT used to correct for buffer overflow” alarms on the CNC, because that usually indicates a 
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handshake problem or an improper FIFO buffer setting. 
 

Tip: By using the button Borrow you can lend settings from another port and use / edit them here. 

 

Diagnostic Tools: 

Test COM Port »Page 48

Analysis Monitor »Page 49

Analyzer »Page 50
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Configure Port Protocol 
Here you can adjust specific settings for manufacturer specific transmission protocols. Most of the 
protocols do not require additional settings or the parameters are self-explanatory. Settings for specific 
protocols can be found here: 

 

Heidenhain Protocol Configuration »Page 28

Tape Reader Protocol Configuration »Page 29
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Heidenhain Protocol Configuration 
Here you set specific parameters for communication when using Heidenhain protocol. As some of the 
parameters are fixed you adjust the controls parameters as follows: 

 

SOH 01 Hex 

STX 02 Hex 

EOT 04 Hex 

ETX 03 Hex 

 

Extension for % Code: 

 

The extension to use for saving %nnnn NC Files at the computer. 
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Tape Reader Protocol Configuration 
Parameters: Choose the appropriate setting of the 3 parameters (0 to 255) for the tape reader Simulator. 

Output format: Select ISO or EIA code for character output. 
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Configure Port Character Handling 
These settings are used to define handling of characters and character sequences during transmission / 
reception of data from / to the machine control: 

 

 
 

Parameters: 

• Send / Receive  Replace: Characters that should be replaced when transmitted, received (e.g. 
translate ISO to EIA). Double-click the character that should be replaced by another and select the 
desired character that should be used instead from the ASCII Table. 

• Send from: Defines a character that should act as a synchronization character for sending data to the 
CNC. All characters before this character are not transmitted (e.g. header information’s that lead to 
errors in the control) 

• Send / Receive  Delete: Characters that should be deleted when transmitted or received. Blacked out 
characters are deleted. You can select single characters by clicking them. To select multiple 
characters hold down the CTRL key and click on the characters. 

• Receive till: Defines a character / sequence that should act as a synchronization character for 
receiving data from the CNC. All characters after this character are not received (e.g. if the end of the 
NC File contains useless characters after the programs code you can define M30 to cut of the 
reception of unwanted data) 

• Store from: Defines a character that should act as a synchronization character for storing received 
data at the computer. All characters before this character are received but not stored in the NC File. 

• Leading Sequence/ Trailing Sequence: When transmitting a file to the CNC, CNCnet DNC can 
automatically send a Leader” sequence before sending the file, or a Trailer” sequence at the end of 
the file. These leader and trailer sequences can be specified here. If left blank, your file will be sent 
as-is” with nothing added at the beginning or end of the file. Sending 000 00 NUL 500 times (the 
field below) before the NC File can be useful if the first lines of the NC File are not received by the 
control (older CNC’s). 
 
Sending 000 00 NUL 500 times after the NC File can be useful if the end of the NC Files content is 
not received by the control (older CNC’s). 
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• With Add (leading and trailing) you can send a specific character or a sequence of characters before 

or after the NC Files content. This is very useful if your CNC requires a special character to accept 
incoming data (Add Leading) or your CNC requires a special character to stop reception (Add trailing) 
or to close the transmission window. 

• EOL: An EOL (End Of Line) sequence is transmitted at the end of each line of your NC File. In most 
cases, an EOL sequence of CR/LF (Carriage Return + Line Feed) will work just fine. For most 
Japanese controls (i.e. Fanuc, Yasnac, etc.), only a Line-Feed (LF) is necessary. Some CNC controls 
require a CR, however. In fact, a few CNC’s (Bridgeport) require both a CR and an LF, and may 
require it in a particular sequence. You may find that some CNC’s require an EOL sequence of 
CR/LF, where others require an LF/CR instead. CNCnet DNC offers 5 choices: LF, CR, CR/LF, 
CR/CR/LF and LF /LF/CR. 

• Binary: The file should be transmitted as is without looking at characters or EOL specifications. This 
is very useful when dealing with binary NC File formats s.a. MAZATROL or STUDER grinding 
machines. 

 

Tools for Analysis: 

Test COM Port »Page 48

Analysis Monitor »Page 49

Analyzer »Page 50
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Configure Remote Commands (Terminal Mode) 
Each CNC operator can send files to the CNCnet DNC system, or receive files from the CNCnet DNC 
system without touching the computer. A set of remote commands” can be defined for each DNC 
window. These remote commands can be tailored to suit the make & model of your CNC controls. When 
an operator sends a file from the CNC, CNCnet DNC will examine the incoming data for a program 
identifier”. If a program identifier is found, CNCnet DNC will use the characters AFTER the program 
identifier as a file name. The incoming data will be stored, and the system will return to normal operation. 
If you want, CNCnet DNC can reply” to the CNC operator by sending back a brief received file 
confirmation” report then next time the CNC operator presses the READ button on the CNC. When a 
CNC operator wants to request a file from CNCnet DNC, he sends a short file from the CNC that 
contains a program request”, followed by the file name. If CNCnet DNC sees this program request in the 
incoming data, it will queue up the requested file and wait for the CNC operator to download it by 
pressing the READ or INPUT button, or to run it in DNC mode by pressing Cycle Start”: 

 

 
 

Parameters: 

• Terminal Mode/Active: Switches on Remote Commands. Definition of the NC Program that should 
be seen as a file, which contains remote commands. If you enter 9999.nc here, automatic code 
recognition is turned on, your synchronization character is % and your extension is set to .nc 
whenever a %9999 arrives from the control CNCnet DNC assumes that remote commands are 
contained. 

 
• Commands: 
Send: If this sequence is found CNCnet DNC assumes that it should send the NC-Filename that follows 
this sequence to the control. 

Directory: If this sequence is found CNCnet DNC assumes that it should send a list of the NC Filenames 
contained in the NC File folder (of this machine) to the control. The list comes in CNC friendly format 
(N01 filenameX, N02 filenemeY a.s.o.) 

Receive: If this sequence is found CNCnet DNC assumes that it should store the following data from the 
control under this filename (Very useful if you have long filenames and the control can only handle 4 
digits) 

Procedure: If this sequence is found CNCnet DNC assumes that it should execute the procedure 
following this sequence on the name of the file given after the command. 

Separators: Characters used to separate parameters (multiple characters are possible) 

Exfiltrate: Characters that should be filtered out of the incoming data (character) stream. 
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Extract (Always): Defines whether CNCnet DNC should take into account the directory alias and / or the 
extension alias (e.g. /S AXA 2331 sends 2331.nc from directory alias AXA to the CNC and /S 2331 DAT 
sends 2331.dat to the CNC) 

Number of lines to scan: Maximum number of lines in the incoming file that should be scanned for 
command sequences. 

Options: Next Port  If switched on, CNCnet DNC assumes that it should perform the commands on the 
next port. This is helpful if you have a CNC that only accepts binary NC File format and you want to work 
with remote commands. You just add a thumb ASCII terminal to the control, connect it to CNCnet DNC 
and place it before the CNC that is also connected to CNCnet DNC. Whenever you enter a command on 
the ASCII terminal CNCnet DNC executes this command on the next port. 

• Options: Fragment  You have NC Files with long filenames and you cannot enter these names at the 
operator panel of the machine (e.g. A344 5F55 BB4556.NC). If you switch on Fragment and type in S 
4556 you get back A344 5F55 BB4556.NC instead. 

• Options: Batch  In one remote control file multiple send commands are contained and should be 
executed sequentially. 

• Messages: What should be sent to the CNC instead of the requested NC File if there are errors in 
the command file or the file was not found. 

• Example: Message  Defines how a message has to be formatted to make it readable for the control 
(You can edit and save different format definitions for every control) 

• Example: Directory  Defines how a list of files in a directory has to be formatted to make it readable 
for the control (You can edit and save different format definitions for every control) 

 

 
 

Tip: The macro symbol $MSG is replaced with the text of the message. 

 

See also: 

Send NC File »Page 13 

 Receive NC File »Page 14
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Configure Port Aliases 
Every machine can have its own set of aliases taken from all globally defined directory and extension 
alias definitions. The aliases you select here are presented in all functions for this machine (like Send NC 
File a.s.o.). Multiple selections are possible but one selection for directory and one for extension have to 
be defined as standard alias for every machine. CNCnet DNC has to know where to look for NC Files and 
store NC Files that come without a specific alias command! 

 

 
 

Parameters: 

• Send/Receive/Directory: All valid aliases for directories. Aliases selected for the machine are blacked 
out; multiple selections can be made by holding down the CTRL Key while clicking the alias. 

• Send/Receive/Extension: All valid aliases for extensions. Aliases selected for the machine are 
blacked out; multiple selections can be made by holding down the CTRL Key while clicking the alias. 

 

See also: 

Configure Aliases for Directories and Extensions »Page 39 
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Configure Port Options 
Here you can lend, save and load settings for or from existent machines.  

Lend Options 

Borrow options from another machine that is already set up: 

 

 
 

Store / Load Options 

Store options for the current machine as an exchangeable parameter .pp file. Load options from a .pp 
file: 

 

 
 

Tip: For compatibility reasons the length for naming .pp files is restricted to 8 digits. 
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Configure System 
Configuration  System 

Global parameters concerning security and miscellaneous settings can be defined in this dialogs. 

System/Security 

Security means all settings for general password protection, levels and available permissions. Password 
protection is built up as follows: 

• 3 protection levels, 0-privileged (highest level), 1-normal (normal level), 2-restricted (without 
password lowest level) 

• You can freely assign all functions of CNCnet DNC to specific password levels. 
• Changing of levels can be made either in the main menus level window 
 

 
 

or by using the command windows Levels menu. 

By entering the predefined password SUPERVISOR (please change this password and note the new one 
if you’re working with password protected levels) you get to the configuration dialog window. 

 

 
 

 
 

Parameters: 

Field Level 0/1: Passwords that already are set up for level 0 or 1. To add a new password for a specific 
level double-click in the free space below the existing passwords and enter a new password for this 
level: 
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• Master Password: Can access this dialog and modify the password system (standard = 
SUPERVISOR) 

• Timeout: Seconds to time out before CNCnet DNC automatically changes from the currently 
selected to the next level below (0 to 1 or 1 to 0) 

• Commands: Here you can assign CNCnet DNC’s functions to specific levels. 
• Find: Opens a pseudo menu were you can find specific commands for level assignment. 
 

See also: 

 Configure System (Miscellaneous)  »Page 38
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Configure System (Misc.) 
Here you can define miscellaneous global settings for CNCnet DNC: 

 

 
 

Parameters: 

• Event Viewer Entries: Number of entries that are stored by the systems logbook storage. If the 
number of events exceeds this value the newer ones overwrite the oldest events. 

• Editor Path: Directory and name of the editors executable that should be used by CNCnet DNC when 
functions like Edit NC File or NC File manager are used. If you’d like to use an own editor please fill in 
the directory AND the editors executable here. 

• Receive File  Backup: Defines whether an incoming NC file should overwrite the existent one having 
the same name or instead create a backup of this file with the selected extension (e.g. .BAK) 

• Long Filenames: Defines whether long (> 8 digits) names for files AND directories can be used or 
not. 

• Largest Buffers: Applies ONLY to OS WINDOWS NT with APICOMM.DLL as device driver for serial 
COM Port hardware. 

• Max. CPU Usage: If set to ON CNCnet DNC reserves ALL available CPU resources for the 
application. 

• Order File: Directory and command file for remote control of CNCnet DNC. The command file just 
contains commands that are executed by CNCnet DNC as the command file arrives and is read by 
CNCnet DNC. This allows automatic sending of NC files to specific controls out of another 
application (like a CAM program) 
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Configure Aliases 
An alias is just a translation of a long, maybe difficult to enter expression into a short name, for example 
N:\\HWK003\99\NCPROG\AXA01\ is translated into AXA1. CNCnet DNC uses alias names for directories, 
file extensions, various storage media and mapped network drives. After you have defined a set of 
globally available aliases you can assign a subset of these aliases to single machines. 

Aliases/Extensions 

Here you can define all available extensions for valid filenames: 

 

 
 

Parameters: 

• Alias (Name): Already existent aliases 
• Extension: The file extension assigned to the alias name 
• Description: Description of the alias 
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To set up a new alias double-click into the free area below the existent aliases. An input window 
appears: 

 

 
 

Enter the alias name and define its associated extension: 

 

 
 

See also: 

Configure Directory Aliases »Page 41 
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Configure Directory Aliases 
A directory alias is just a translation of a long directory name into a short name, for example 
N:\\HWK003\99\NCPROG\AXA01\ is translated into AXA1. CNCnet DNC uses alias names for directories, 
file extensions, various storage media and mapped network drives. After you have defined a set of 
globally available aliases you can assign a subset of these aliases to single machines. 

Aliases/Directories 

Here you can define all available directories for valid NC Files: 

 

 
 

Parameters: 

• Alias Name for Directory: Name of the Alias as shown in all functions of CNCnet DNC. 
To set up a new alias double-click into the free area below the existent aliases. An input window appears 
where you can enter the name of the alias: 

 

 
 

Specify the directory by entering its name or search for it by clicking the Path button: 

• Path that corresponds to Alias: Directory that belongs to the alias 
• Description: Description of the alias for information purposes 
 

Tip: You can also define Aliases for physical Drives (like A:..), mapped network drives (like N:..) or USB 
memory sticks. 
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Configure Processors 
Processors are programs that process input data to produce output that is used as input to another 
program. The output is said to be a processed form of the input data, which is often used by some 
subsequent programs like CAM applications. The amount and kind of processing done depends on the 
nature of the processor, most processors are performing relatively simple textual substitutions and 
macro expansions. 

A Preprocessor runs before the NC File is sent to the machine whereas a Postprocessor runs after 
reception of an NC File from the machine. Typical cases of applications are: 

• Separation a NC File into pieces (main program  sub program) 
• Translation of the NC File format from one machine type to another (e.g. from Fanuc 4-axis wire 

EDM to AGIE 4-axis) 
The processors configuration window can be launched from the command windows Configuration menu  
Processors. A window with active processors that are already configured is shown: 

 

 
 

Click on the button Edit or double-click on a processor to change an existent processor definition. 
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Double-click into the free space below the existent processor definitions to add a new one: 

 

 
 

Parameters: 

• Processor: Name of the executable (Processors have to be stored in the \PROCS subdirectory of 
CNCnet DNC) 

• Active on Port Number: Number and Name of the Machine for which the processor should be active 
• Working Directory: Working directory (alias !) where the processor should look for NC Files to 

process  
• File Mask: Definition of Files that should be modified by the processor (e.g. *.NC = just modify .NC 

Files) 
• Parameters: Additional command line parameters for the processor according to the processors 

purpose 
• Processor Type: Should the processor get started before a NC File is transmit to the machine (=Pre) 

or should it process data received from the machine (=Post). CNC specific formatting of tool-preset 
data is a Preprocessor task whereas division of one NC-File into several NC Files is a Postprocessor 
task. 

 

Tip: Processors compiled with a 32-bit compiler can be simply started by the auxiliary program 
START32.EXE. As processor select START32.EXE and fill in a /P in the Command Line Parameters field 
followed by the name of your processor without any white space characters between /P and your 
processor. Is your processors name CAMNEW.EXE you just have to enter /PCAMNEW eventually 
followed by your specific switches for execution. 
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Tools 
Event Viewer 
The event viewer stores and shows all activities performed by CNCnet DNC: 

 

 
 

Parameters: 

• Date: Filter events by a range of dates 
• Events to show: Filter specific events to be shown by the viewer 
• Refresh: Refresh current view 
• File: Store current view as an ASCII text file 
Tip: Press the button Refresh or ALT+R to update the current view after changing the range of dates or 
filtering out specific events to show. 
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Lock 
Completely locks CNCnet DNC for all users input. When locking CNCnet DNC you’re asked for a 
temporary password: 

 

 
 

To unlock CNCnet DNC the same password has to be entered again, so do not forget your temporary 
password! 
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System Info 
Shows system information’s about the current configuration of CNCnet DNC: 

 

 
 

Contents: 

 

• Hardware RS232: Shows if any serial RS232 ports are available on the computer 
• Software Protection: Detects the presence of CNCnet DNC’s software protection (if no software 

protection can be found CNCnet DNC runs in limited DEMO mode) 
• RS232-Treiber: Name and version of the port driver currently used 
• System: Various information’s about the computers capabilities 
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Diagnostic Tools 
For visualization and diagnosis of transmission processes CNCnet DNC contains a comprehensive set of 
diagnostic tools: 

 

Test of COM Port: Test COM Port »Page 48

Show and manipulate traffic between this computer and a CNC machine: Analysis Monitor »Page 49

Show and manipulate traffic between another computer and a CNC machine (wiretapping): Analyzer 
»Page 50

Show protocol specific message flow: Status Indicator »Page 51

Simulation of NC File transmission without a machine: Simulate Terminal Mode »Page 52
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Test COM Port 
By performing a COM port test you can ensure that your COM ports are working properly: 

 

 
 

To perform the test you need a loop back connector (soldered bridge between TXD/RXD, RTS/CTS and 
DTR/DSR). Plug in this connector to the serial port you’d like to test. If the port is working properly the 
red crosses disappear and a green hook appears. 

Parameters: 

• Hold: If switched on the status of the currently selected port does not change after you plug in the 
loop back connector into the next port. 
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Analysis Monitor 
By using the analysis monitor you’re able to visualize and store all characters that are sent and received 
during transmission. The analysis monitor also shows the status of the handshake lines RTS and CTS 

The analysis monitor is active for the machine that was selected before turning on the monitor tool. 

 

 
 

Possible parameters are: 

ASCII or HEX (Displays characters in ASCII or hexadecimal format) 

Auto-Recording Continuous recording of transmitted characters 

Ring Working mode of the monitor. If Ring is turned on the oldest events are overwritten by newer 
events as the buffer of the monitor reaches its limit. 

Time Displays seconds with the symbol '' 

7 Bit Removes the 8th bit in the current view 

By using the buttons in the lower pane you can start or stop the monitor or as well delete the contents of 
the current view. By clicking the button Save you can store all recorded events in an ASCII file. The 
buttons Send and Rec. allow manual sending and reception of characters and character sequences. 

 

Tip: By using the button send you can quickly test the reaction of the control on reception of specific 
control characters. If the control requires for example a 008 08 BS to stop reception you can send this 
character by using the monitors send function. 

Tip: By using the button Rec. you can quickly simulate the reaction of CNCnet DNC on incoming control 
characters or sequences of them (e.g. useful for setup of automatic code recognition) 
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Analyzer 
The functionality of the analyzer is equal to the functionality of the monitor. The only difference is, that 
the analyzer allows wiretapping of all transmission activities between another computer and a CNC 
machine. To use the analyzer you have to build up a special cable that allows catching of characters: 

 

 
 

A description of the monitors functions can be found here: Analysis Monitor »Page 49 
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Status Indicator 
The status indicator shows all internal messages of CNCnet DNC. The status indicator tool can be used 
simultaneously with other tools, it can even be left active during normal operation of CNCnet DNC: 

 

 
 

In the right pane you can select instances to be shown or hidden by the tool. Blacked out instances are 
active. 

Setting the switch Refresh to on forces CNCnet DNC to refresh the viewer 

Use the Clear button to remove the displayed messages from the viewer. 
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Simulate Terminal Mode 
Sometimes its better to simulate a connection between CNCnet DNC and the machine instead of to and 
froing between computer and machine: 

 

 
 

Tip: If CNCnet DNC is working in DEMO mode port 1 and port 2 are taken for the simulation of terminal 
mode. 

 

See also: 

Configure Terminal Mode »Page 32 
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Examples 
Examples 
This example shows the setup of a typical connection between CNCnet DNC and a CNC machine. 

Set the parameters and activate a connection (normal mode): 

Procedure 

• Set the parameters at the control and write them down 
• Set the parameters in CNCnet DNC according to the ones in the control 
• Activate the port 
• Test the port 
• Transmit an NC File from the control to CNCnet DNC 
Basic state of CNCnet DNC 

The port is switched off and no settings are made for this port: 

 

 
 

Set the parameters at the CNC 

When setting up CNCnet DNC you always begin by setting of the CNC’s parameters. Please read the 
manual of the control, set the desired parameters for speed and handshake and write them down. 
(Hardware handshake = RTS/CTS, software handshake = XON/XOFF). In this example we have: 

• Machine: Gildemeister NEF 600 Control: Sinumerik 840 D 
• Communication settings: 9600 baud, 8 data bits, no parity, 1 stop bit 
• Handshake: Hardware (5 wire cabling incl. ground) 
 

Continue with: Set Parameters in CNCnet DNC »Page 54 
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Set Parameters in CNCnet DNC 
Change the operation level to 0 privileged to allow changes of parameters 

 

 
 

Select the port to operate on, click on port with left mouse button 

 

 
 

Select Configuration  Port  Parameters 

 

 
 

• Set the name of the machine 
• Set mode to Normal 
• Click on OK to leave this dialog window 
Machine and State have changed in the main window: 
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Select Configuration  Port  I/O 

 

 
 

• Set the parameters according to the parameters of the control 
• Click on OK to leave this dialog window 
 

Continue with: Activate and Test Port »Page 56 
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Activate and Test Port 
Select Command  Enable Port 

The state of the port changes as follows: 

 

 
 

Test COM Port 

Select Tool  Diagnosis  Test Port 

 

 
 

• Plug the test connector into the COM Port 
• The selected Port has to show green hooks at the Rx/Tx, RTS/CTS and DTR/DCD fields. 
 

Continue with: Transmit a NC File from CNC »Page 57 

 

 

 

 

Tools for analysis: 

Analysis Monitor »Page 49

Analyzer »Page 50

Status Indicator »Page 51
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Transmit a NC File from CNC 
Select Command  Receive NC-File 

 

 
 

• Enter a name for the NC File 
• Confirm by clicking OK 
The state of the port changes: 

 

 
 

• Start transmission of the NC File at the CNC machine. 
 
During active transmission the main window of CNCnet DNC shows the received bytes. When 
transmission is complete the state of the port returns to its previous state: 

 

 
 

Continue with: Send NC File »Page 13 
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Appendix 
Cable Construction 
Serial cable construction from a computer to the control 

Pin assignment at the computer 

Serial plugs at the computer are always 9-pin or 25-pin male D-SUB connectors. CNC network adapters 
have a 9-pin male D-SUB connector. 

Pin assignment at the control 

Pin assignments at the CNC may vary from manufacturer to manufacturer. In most cases the correct pin 
assignment can be found in the manual of the control. Fortunately most common controls have the same 
pin assignment as the computer. Sometimes the pins of the plug at the control are pre-crossed, means 
in practice that the pins RXD and TXD as well as RTS and CTS plug at the control are interchanged (this is 
not serial RS232 standard!) 

To find out the correct pin assignment of the control you have to use a RS232 inline breakout box with 
LEDs on top: 

• LEDs 2 and 4 are active: The cable has to use crossover wiring, means that pin TXD at the control is 
connected to pin RXD at the computer and pin RTS at the control is connected to pin CTS at the 
computers port. Pin RXD at the control is connected with pin TXD at the computer and pin CTS at 
the control is connected to pin RTS at the computers port. (See crossover wiring) 

• LEDs 3 and 5 are active: The cable has to use straight wiring, means that pin TXD at the control is 
connected to pin TXD at the computer and pin RTS at the control is connected to pin RTS at the 
computers port. Pin RXD at the control is connected with pin RXD at the computer and pin CTS at 
the control is connected to pin CTS at the computers port. (See straight wiring) 

• If LEDs 4 or 5 are not active then it is very likely that the control has no hardware handshake 
available (see Software Handshake wiring) 

• If LEDs 6,8,15 are active it is very likely that the controls port is a RS-422 connector that cannot be 
used for data transfer. 

• Your cable is wired correctly if the first 4 LEDs are active in case you’re using a control that supports 
hardware handshake and the computer is also connected to the cable. 
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ASCII Table 
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